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TLE985x Overview

Z8F64770112

Infineon Embedded Power ICs Product Portfolio
based on Arm® Cortex®-M processor

Smart Relay IC

Smart Half Bridge

Smart H-Bridge Driver

Smart BLDC Driver IC

12V from Battery
=

] .
LIN or PV

12V from Battery =

VREG

VREG

Half Bridge|

TLE9851 MOSFET TLE985x TLES87x
Driver fver
LIN ar PWHI
A‘-’l‘ [Poriphrals)

lemors

TLE9842/3/4 TLE9845/TLE9851 TLE985x/TLE986x TLE987x
>  Window Lift »  HVAC Fan > Window Lift > Fuel Pump
>  Sunroof > Engine Cooling Fan > Sunroof > HVAC Fan
> Wiper > Fuel Pump > Wiper > Engine Cooling Fan
> Water Pump > Power Folding Roof > Water Pump
> Power Sliding Door > Oil Pump
> Power trunk/ tailgate > Sunroof
> Wiper
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Evaluation Board and Kit Overview

TLE985x — Evaluation Board

2-Phase N-MOS Bridge

Single Shunt in GND path
Integrated LIN transceiver

4 push buttons

Debug LEDs

Onboard Segger J-Link Debugger
EvalBoard-PC connector: USB
ulO stick connector

TLE9855 — Evaluation Kit

2-Phase N-MOS Bridge

Single Shunt in GND path
Integrated LIN transceiver

Debug LEDs

Onboard Segger J-Link Debugger
EvalKit-PC connector: USB

VOOV WV WV VY VY YV WV

VOOV WV VWV WV
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TLE985x EvalBoard Overview
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TLE9855 EvalKit Overview
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TLE985x: Documentation

(infineon

Z8F64770112

Collaterals and
Brochures

Technical Material

Evaluation Boards

Software & Tools

Product Brief
Selection Guides
Motor Drive eBook

Datasheet
Application Notes
Getting Started
PCB Design Data
User Manual

Evaluation Board
Evaluation Kit

Config Wizard

Keil yVisions
Software Examples
Infineon Toolbox

Link to family page

Link to Documents

Link to Boards

Link to Software & Tools

2019-04-11
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https://www.infineon.com/tle985x
https://www.infineon.com/tle985x#!documents
https://www.infineon.com/tle985x#!boards
https://www.infineon.com/tle985x#!tools

Support | fnfineon
Online tools and services

> infineon.com/embeddedpower

I Newsletter I Contact iwhere to Buyl English ~ & mylnfineon~ ¥ Cart Search Q
Infineon . . (1]
C/ Products  Applications About Infineon  Discoveries Careers

Subscribe to
Newsletter

>Home > Products > Microcontroller (MCU) > 32-bit Embedded Power ICs based on ARM® Cortex® M

32-bit Embedded Power ICs based on ARM® Cortex® M ()

@  Overview 32-bit Embedded Power ICs based on ARM® Cortex® M subcategories Wh ere tO B u y

Highlights

Detail > Relay Driver IC with Integrated ARM® Cortex® MO » H-Bridge Driver IC with Integrated ARM® Cortex® M3
etails

Documants > Half-Bridge Driver IC with Integrated ARM® Cortex® MO » 3-Phase Bridge Driver IC with Integrated ARM® Cortex® M3 6

Boards H

Tools, Finders

Tools & Software Infineon 32-bit Embedded Power ICs based on ARM® Cortex®-M are designed for automotive motor control solutions. They integrate on single die the 32-

vid bit microcontroller, the non-volatile flash memory, the analog and mixed signal peripherals, the communication interfaces along with the driving stages an d Sel eCtO I'S
ideos

needed for either relay, half-bridge or full-bridge DC and BLDC motor applications.

Partners Bridge Driver with a current controlled output stage, flexible charge- and discharge current settings and several diagnostic functions allows optimizing

your system with our products. These highly integrated products save space and energy, improve the overall system reliability through advanced e
diagnosis features and reduce the overall cost due to a minimum number of components. Theye are perfectly fit with a range of motor control

applications where a small package form factor and a minimum number of external components are essential. Such applications include window lift,
sunroof, wiper, fuel pump, HVAC fans, engine cooling fan and water pumps, to name but a few. S u p p O I"t

Applications

32-bit core for complex software solutions with Direct Memory Access (DMA) Controller up to 14 channels ensure high performance for applications.

>Home >Products > Microcontroller (MCU) > 32-bit Embedded Power ICs based on ARM® Cortex® M

Overview AppNote for Reverse TLE986x/TLE98Tx FAQ Application Note Solution Finder for
— Polarity Protection BridgeDriver AppNote for TLE984xQX Automotive Applications
@ tignights W Licon s & ) i i | @ veormore Forum
Details
Documents
Boards
Tools & Software
Videos
Explore our Infineon Forum for Embedded Power ICs
Partners
Applications
Support
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Toolchaln installation: General Overview

Infineon Embedded Power ICs are supported by a complete development tool chain provided by Infineon and
third party vendors. The tool chain includes compilers, debuggers, evaluation boards, LIN low level drivers and
configuration tools as well as a variety of example software code.

: : : : : : Download
Download and  : : : : Download : : the SDK via
install : : Download . : and install : : Visions
Keil LVisions : : Infineon Toolbox  : : Seqger : : P ukl I
= : : : :  J-Link Driver : ack Installer

(See step 1)

> !o(mEby!\h Cinfineon W Cinfineon

Arm® Keil pvision is an Infineon provides the SEGGER J-Link is a widely The Embedded Power Software
integrated development Infineon Toolbox which is used driver for on-board or Development Kit (SDK) is a low
environment which consists of designed to install and use stand-alone debuggers. level driver library which can be
code editor, compiler and Infineon plugins and tools. downloaded within “Keil pVision”
debugger. via the “Pack Installer”.

2019-04-11 Copyright © Infineon Technologies AG 2019. All rights reserved.


https://www.keil.com/demo/eval/arm.htm
https://www.infineon.com/cms/en/product/promopages/Infineon-Toolbox/
https://www.segger.com/downloads/jlink/JLink_Windows.exe
https://www.segger.com/downloads/jlink/JLink_Windows.exe

(iﬁmeon
Toolchain installation: 1/4
SIKEIL "o kE

uVision=5

Integrated Development Environment

KEIL is a trademark and pVisio ered trademark of ARM Ltd. All rights reserved.

. . .
Ke I | HVI S I O n 5 This product d by US and international laws.

> Code Editor & Online Debugger > Download from:
https://www.keil.com/demo/
eval/arm.htm

— Evaluation version can handle up to
32K

Main Window Pack Installer

it KOt s oot M b et s sl 9% = Wpmdem ol
NEE@| ¢ @[ | -~ [wnanZznne Haslale el
CBE @ |9 o
Project
=78 Project Test
6 Torgetl

14 (3 Source Group 1

& o

@@ Device

& ] bootrom.c (SDKBOOTROM) _ADC2_DEFINES_H

& inte (SOKIND) Taocapeemnes s
& oo IFKConigRizazd Verston
i ) « IFXConfigWizaTd Versien 1.8.1
21 wou.c sokwoTn)

1) adc2_defines.h (ContigWiaard)
1 bdrv_defines h (ConfigiWaard)
1) b definesh (Statug)

1) ceub_defines.h (ConfigWizard)
1) configicwp (ConfigWizard)

1] csa_defines.h (ConfigWizard)
L] dma_defines.h (Configizerd)
] gpti2e defines.h (ConfigWizard)
L) it defines.h (ConfigWizard)

1) mon_defines.h (ConfigWiizard)

]
ovogect [@rcons () Functions | Dy Tempiates

2019-04-11 Copyright © Infineon Technologies AG 2019. All rights reserved.



https://www.keil.com/demo/eval/arm.htm

Toolchain installation: 2/4

Infineon Config Wizard

Configuration of chip modules

Device description for TLE985x
iIncluded

Installation from Infineon Toolbox

TLE985x supported by Keil pVision 5

(in’ﬁneon |

Z8F64770112

Boot Strap Loader SCU PMU MON Interrupt PORT ADC1 ADC2 HS BEDRV coL |k

Structure

v VDDEXT
Turned on
Cyclic 5ense enable
Fail Interrupt

Cyclic Wake enable
Cyclic Sense enable
LIN wake up
MON wake up
GPIO wake up
Wakeup Interrupt
Reset Settings
Power Saving Modes
Supply Interrupt

<

Settings

|
a

OO

Log Script

Loaded configuration: config.icwp. Mo headerfiles written. To update configuration please save this file!

2019-04-11 Copyright © Infineon Technologies AG 2019. All rights reserved.
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Toolchain installation: 2/4

Infineon Toolbox: Config Wizard for Embedded Power ICs:

» (%)

— Install the “Infineon Toolbox”"’ and start the tool

— Within the Infineon Toolbox:

1. Select the tab “Manage tools”, search for “Config Wizard for Embedded Power
ICs” and click “Install”

Launchar]

Infineon _
Toolbox Tools | v [EEERINEEES A0M%BBRB
BRScanQRcode  Mytools Manage tools
ABCDE G K LM o P RS T X
C
Config Wizard for Embedded Power ICs Version: 2.1.26.201901250941
Tags: ATV, Embedded Power
Config Wizard for Embedded Power ICs allows easy configuration of Automotive Embedded Power ICs, Config Wizard Details

IC products.

() For more details about the Infineon Toolbox installation, please read the Installation Manual.

2019-04-11 Copyright © Infineon Technologies AG 2019. All rights reserved.


https://www.infineon.com/cms/en/product/promopages/Infineon-Toolbox/
https://www.infineon.com/dgdl/Infineon-Toolbox radar download process-SW-v01_00-EN.pdf?fileId=5546d46264a8de7e0164b35b41ca199d

(infineon

Toolchain installation: 2/4

Infineon Toolbox: Config Wizard for Embedded Power ICs:

2. Start “Config Wizard for Embedded Power ICs” once to trigger the
integration into Keill

#
——

Config Wizard for
Embedded Power ICs

Details

3. Close the Config Wizard and the toolbox

2019-04-11 Copyright © Infineon Technologies AG 2019. All rights reserved.



Toolchain installation: 3/4

(infineon

Z8F64770112

Segger J-LINK-Lite driver:

— Driver for 'on-board' or
'stand-alone' debugger

— Install driver from:
https://www.seqgger.com/jlink-

software.html

Cortex JLink/JTrace Target Driver Setup

)

—dJ-Link / J-Trace Adapter

Debug |Trac.e I Flash Download I

SN: |591073990

Device: | J-Link Lite-XMC4200 Rev.1

—SW Device

| IDCODE Device Name Mave

SWD | @ 0<0BB11477  ARM CoreSight SW-DP

HW: | V10D  di:| V6.00a

FW: |J-Link Lite-XMC4200 Rev.1 o

Port: Max Clock: % Automatic Detection
Isw j |5 MHz LI " Manual Configuration
Auto Clic | Add | Delete | Update |

|0 CODE: I
Device Mame: I
IR len: I

[
B

Do

Connect & Reset Options

’7 I™ Reset after Connect

Connect: Iwith F‘re-rese;l Reset: INorrnaI

=l

|- Cache Options
[ Cache Code
¥ Cache Memary

Download Options

[~ Venfy Code Download
[~ Download to Flash

M
Misc:

—Interface

TCF/IP

& USB (" TCP/P VERGEIE FETED .
IP-Address Port (Auto: 0) Autodstect | ik o |
Scan .
[ o= | EEE ¢ Fing | JLink Cd |
State: ready
| ok | cancel | ipoy |
2019-04-11 Copyright © Infineon Technologies AG 2019. All rights reserved.


https://www.segger.com/jlink-software.html

(infineon

Toolchaln installation: 4/4

PACK-file TLE985x for pVision5:

— Device database for all ___
TLE985X Variants Install or update Software Packs that

contain Software Components

" Packs Examples I
Pack Action Description

— Device support for flashing/erasing
TLE985x

[l

I_;|----D:evice Specific LE985x Series selected
1 ﬁ Install | hfineon TLE9S5x Series Device Support
[-Generic acl

— Device description for TLE985x for
Config Wizard

— Includes SDK (Software L
Development Kit) T SR it

74 Devices

evices

0[3 TLES84x Series 7 Devices
. . % X SEries evices
- If the TLE985X SDK IS not avallable E %_E?ri;s@m 1;\«1 Cortex M0, 40 MHz 4 kB RAM. 64 kB ROM
. . ) 8 Tuesss3ox ARM Cortex-M0. 40 MHz 4 kB RAM. 48 kB ROM
in the paCk |nsta"er, you can load it : TLE9ES40X ARM Cortex-M0, 40 Mz 4 kB RAM, 64 kB ROM
. . - ARM Cortex-MO, 40 MHz, 4 kB RAM, 96 kB ROM
from a local file using the “File- 7% TLEaB S SDevies

>|mport” menu.

2019-04-11 Copyright © Infineon Technologies AG 2019. All rights reserved.
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Getting Started: Infineon Embedded Power SDK @
Keil uVision5 Template

1) Create a new Project

> Open Keil mdk ——

Mew uVision Project...

Mew Multi-Project Workspace..,

) GO to 9 PrOJeCt Open Project...
- new pVision Project

Export

> Name project: “TLE9855QX_test ||w

Euild Qutput ,ﬂ\ Opti

.......

Select Device for Target ‘Target 1'.. x

> Select Device: soe |

. Vendor:  Infineon
— Infineon A

Toolset: ~ ARM
Search: I

Description

— T L E 9 8XX S e r i e S E] “ %.EEE z%z:eia N -] Rﬁf@%ﬁ%ﬁ:ﬁi “:or motor drive applicalions with
- « Series - Utra low power consum
— TLE985x Series
— TLE9855QX

ISoﬂware Packs LI

ption
- Nested Vectared Intermupt Controller (NWIC)
A TLesesiow - Integrated LIN tranceiver fselected derivates)
@ TLE9S530X - Integrated MOSFET Driver and Change Pump for H-Bridge

- Current Sense Amplfier
-8 TLE98550X
QF

[ cbx Series
%2 TLEGET Series

OK Cancel Help

2019-04-11 Copyright © Infineon Technologies AG 2019. All rights reserved.




Getting Started: Infineon Embedded Power SDK Tfineon
Keil uVision5 Template

2) Configuration of Run-Time Environment

v

Expa n d : “ DeVice” Manage Run-Time Environment .

Software Companent Sel.  Variant Version  Description
-4 cmsis Cortex Micracontroller Software Interface Components
& CMSIS Driver Unified Device Drivers compliant to CMSIS-Driver Specifications
—_ C h k . S 4 Compiler ARM Compiler 140 Compiler Extensions for ARM Compiler 5 and ARM Compiler 6
e C . tartu p 54 Device Startup, System Setup
@ Sta rtup l7 1.0 System Startup for Infineen TLES84x device series
@ ConfigWizard i 187 Infineon ConfigWizard Configuration File
. . @
—_— C h k . C f W d & File System MDK-Plus <6100 | File Access on verious storage devices
e C L] O n I g I Z ar . Graphics MDK-Plus w5465 User Interface on graphical LCD displays
MDK-Plus v|780 1Pv4 Networking using Ethernet or Serial protocols
MDK-Plus v |6124 | USB Communication with variaus device classes
.
y  “Sel.” window ! e
.
Validation Output Description
- /L Infineon:Device:Startup. Additional software components required ﬁl
bac kg round is oran ge © reare Doresaescy
iy Infineon::Device:SDK:SCU System Control Unit (SCU) driver for TLEGB4x |

Detals ok | cancel Hep |

> Press: “Resolve”

Manage Run-Time Environment X
111 ”» - Software Component Variant Version  Description
) S e I WI n d OW ‘ CMSIS | Cortex Microcontroller Software Interface Components &
" . CMSIS Driver ‘ Unified Device Drivers compliant to CMSIS-Driver Specifications
. € Compiler | ARM Compiler 140 Compiler Extensions for ARM Compiler 5 and ARM Compiler 6
backaround is now areen 5 @ Deice - T
@ Startup 1100 |System Startup for Infineon TLES8Tx device series
@ ConfigWizard 1.86 Infineon ConfigWizard Configuration File

@ BF-Stepping

> Expand “SDK”" 8150

001 | Select ‘i’f‘tnrget‘dev‘i’ca‘is BF-’S!;ggiﬁg

MDK-Plus 6.10.0 File Access on various storage devices

| <
’ Graphics ‘ | MDK-Plus v |546.5 User Interface on graphical LCD displays i
’ Network | ‘]MDK-Plus v|7.80 1Pv4 Networking using Ethernet or Serial protocol.
& use [ | MDK-Plus v|6124  |UsBC ication with various device classes

— Check “TIMER2x" - '

Validation Output Description

S
|
> Continue with “OK” —1 T ] |

2019-04-11 Copyright © Infineon Technologies AG 2019. All rights reserved. 20




Getting Started: Infineon Embedded Power SDK @
Keil pVision5 Template

3) Using '‘Main' template

» Expand: “Target 1”

=24 Project: Arduino_shield
= &7 Target 1

-3 Source:
,QQ Options for Group ‘Source Group 1'...

»  Right click on: i
“Source Group 1” i e

(%4 Rebuild all target files
[£] Build Target

Add New Item to Group 'Source Group 1'...

> Choose: Add New Item to e
Group “Sou rce Group 1 ? |E Show Include File Dependencies '

> Choose “User Code aenteno o soeso .

@ CFie (2) Add template file(s) to the project.

)
Tel I I plate * Component Mame
@ Cex File (cpp) % Device
\ﬂ Asm File (s) - Startup with full 5DK | Complete Main I

»  Expand “Device” %

> Choose: ” o
“Startup”

» Continue with “Add” N = -
[ add || cose -Help

Type: I User Code Template

2019-04-11 Copyright © Infineon Technologies AG 2019. All rights reserved.



Getting Started: Infineon Embedded Power SDK @
Keil uVision5 Template

4) Using Config Wizard V2

) Open Config Wizard by File Edit Wiew Project Flash Debug Peripherals  Tools  5VCS  Window Help
choosing Tools > Config NEE@| % LB[9C|eo|H Shwrcm E

. @ bl [ @ ’ E‘e1| ¥4 | TLE985« EvalBoard E Lint All C/C++ Source Files
leard V2 Project ol - | bdi

£ “ Project: BDRV_CCUE_ADCI_MOTOR_EXAMPLE_TLI = Configure Merge Tool... b
. . . . ElﬁI TLEG85x_EvalBoard Customize Tools Menu.., _50
> Config Wizard will open in a & B App ——

1 |j main.c EniTgiIar “;*
H . . i
separate window & v — .
Et Device AXXARAEA AN AL

@J ICW_TLE985x.xml (ConfigWizard) TLE_Init(}:
!g ILEﬁ?Xh FSt?:EUp,)_ PCRT_ChangePin|(

@ Config Wizard C:\Users\estadieu\Documents\RTE\Device\ TLE98350X\config.icwp = O X
File Extras
Boot Strap Loader sCU PML MOM Interrupt PORT ADC1 ADC2 H5 BORV o lzl e
Structure Settings
5YS 40MHz

> Clock Configuration

Log Script
Loaded project: config.icwp. No headerfiles written. To update your configuration please save this file!

C:\Users\estadieu\Documents\RTE\Device\TLE| Infineon Toolbox Version 2.1.12.2018101009:

2019-04-11 Copyright © Infineon Technologies AG 2019. All rights reserved.




Getting Started: Infineon Embedded Power SDK @
Keil uVision5 Template

5) Using Config Wizard V2: Timer2 Configuration

> Open “Timer 2x” section

) Enable “Conflgure Tlmer” BootStraploader ~ SCU PMU  MON  Interrupt PORT  ADC1  ADC2 HS BDRVY C

Structure Settings

checkbox ¥ Contgre T U —
Timer2 Clock 3.33MHz
Max. Period 19660.5us
. » Clock Setting
) GO tO. » Muode Select

»  External Capture/Reload Event Enable O
O

“‘Reload / Capture Register” ) Bdema Sart Enstle

» Timer Register
~ Reload / Capture Register

13 ] > as clock ticks O
— Enter "1000” ps v Crimeta o .

Reload Value OxF2Faticks

> Go to: “Interrupt” T
. p > External Interrupt O
¥  Overflow / Underflow Interrupt 1 —
Enable Interrupt |

— Enable Overflow Interrupt sk s |

> Pin Select
» Configure Timer21 O

— Type “task_1ms” in
“Call Back” line

2019-04-11 Copyright © Infineon Technologies AG 2019. All rights reserved.



Getting Started: Infineon Embedded Power SDK

Keil uVision5 Template

infineon

Z8F64770112

6) Using Config Wizard V2: Port Configuration

Interrupt | PORT

ADC1 ADC2 HS

BDRYV CCus GPT12E  Timer2x UART

“File” -> “Save”

Boot Strap Loader SCU PMU MON
PO.O PO.1 P0O.2
) Select “POR I ” Section Structure Settings Structure Settings Structure Settings
Input Input (@] I =
Dt  oamt ®
1 ” H
) O 10 the £ Seclion
Structure Settings Structure Settings Structure Settings
Input O] Input ® Input ®
- - » Output (@] > Qutput O > Qutput O
» Configure pin to
“O t t” d PO P21 P2.2
u pu l I IO e Structure Settings Structure Settings Structure Settings
Input ® Input ® Input ®
Disabled O Disabled O Disabled (@]
Boot Strap Loader sCuU PMU MON Interrupt PORT ADC1 ADC2 HS EDRY (o}
PO.O PO.1 PO.2 P0.3
Structure = Structure = ructure Se & Structure o
Input Input { Output ® Input (
> OQutoit b 5 Outnut J{+ Nata Y > Outnut v
< > < > < > < >
. PLO PL1 PL2 PL4
) Save Wlth Structure @ Structure QX Structure ® Structure ®
Input 4 Input [ Input 4 Input (
> Outout v > Outout v > Outout [ > Outout [

Expnrted Imaderﬁle: C: NsersJ'estadleufDommemszTEfDewoeﬂ'LESS5SQKJ'moH deﬁnes h
Exported headerfile: C: Users/estadieu/Documents/RTE [Device [TLES855QX /pmu_defines.h
Exported headerfile: C: /Users/estadieu/Documents /RTE [Device [TLESE55QX fpart_defines.h
Exported headerfile: C: JUsers/estadieu/Documents/RTE /Device TLES855QX /scu_defines.h
Exported headerfile: C Nsers,{estadleufDommemszTEfDewoeﬂ'LESS5SQK,i'ssc defines.h
Ex

o hmEer deﬁnes h
—

Saved pmject: C: NsersJ’estadleu,fDommenmfRTE,fDewoerl'LEQS5Sijoonﬁg |cwp

2019-04-11

Copyright © Infineon Technologies AG 2019. All rights reserved.




Getting Started: Infineon Embedded Power SDK @
Keil uVision5 Template

7) Finish Code in “main.c”

> Go to Kell MDK

B2 [L:l ll.l"J.J.J.J.J.J.J.J.J.J.J.J.J.J.J.J.J.J.J.J.J.AAAAAAALAAALAAAAAAAAAAA.

) Start Tlmerz before the 83 ** place your application code here

3& - R LR R i S R R R R R
111 e \V
or(;; oop as TIMER2 Start ()i
BEI:_:I o e o e o e e e e e e e e e
87 ** main endless loop

A R R R R R R R R R R R R R R R R R R R R R R

>  Write function definition of ss

g9 for (::)

interrupt callback S0E

> Use API function
“PORT_ChangePin()”

» “Save” and “Build” project

== L:_lllll"l.J.J.J.J.J.J.J.J.J.J.J.J.J.J.J.J.J.J.J.J.J.J.J.J.J.J.J.J.J.J.J.J.J.J.J.J.J.J.J.J.J.J.J.J.J.

: —— _ 56 #% Priwvate Function Declarations

F“flEd'tllll"EW Project Fla R S TS SR
3 NE d ﬁ| R 58 fvoid task 1ms()j
: - 59 PORT ChangePin (0x02, PORT ACTION TOGGLE);
S e | B ey OO
Proje
= *t% Project: TIMERZBLINK

2019-04-11 Copyright © Infineon Technologies AG 2019. All rights reserved.




Getting Started: Infineon Embedded Power SDK @
Keil pVision5 Template

8) Power up Evaluation board

>  Connect micro USB cable

> Supply board via banana jacks (VBAT, GND)
> Debug LED lights up

L ————————
, :
Cortex JLink/ITrace Target Driver Setup - A . - [ = |
9) Connect Debugger Debug | Trace | Flash Download |
- Hink / HTrace Adapter SW Devi
e

SN [6310733%0 | IDCODE | Device Name |

Device: | J-Link Lite-XMCA200 Rev. 1 SWD| @ 0x0BB11477  ARM CoreSight SW-DP Up
) GO tO HW Vioo  di:| VE0Ga Down
—.I d= e @ | . [Vioo__a:[ Vios_ o]

| i Max Clock: @ futomatic Detection 1D CODE:

dﬁ{ Options for Target... m [5MHz =] || € Manusl Configuration  Deviee Name

) ChOOSG ? Conﬂgure target options i Auto Clc scd || Delete | [Update| IR len

 Use: IJ-LINKKJ—TH}\CE Cortex LI Settings | I~ Reset after Connect ¥ Cache Memory | | ™ Download to Flash

. - Linker Debug | Ltilities I - Connect & Resst Options ————— [ Cache Options Download Options
- Debug->use. J-Llnk q | Connect: [wih Preese | Reset: [Nomal ~| |Izcad1€ Code I~ Verify Code Download

rInterface
@ Use ¢ TCPAP

Scan

State: ready

TCPAP
Network Settings

e Port (utorq) | Autodetsct ik o I
o o7 =[O Fing JLink Cmd

— Go to “Settings”

>  SWD connection established when “IDCODE”
is visible

ok | caneel | gy |
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Getting Started: Infineon Embedded Power SDK @

Keil uVision5 Template
10) Download and run code
> Press: “Load”- button or Press: ) rarges Hé&

1] F8” ¥4 Download (F8)

1 Download code to flash memory .

>  “Flash Load finished” is shown in e
“Build Output” window

Programming Done.
Verify OK.
Flash Load finished at 12:33:59

4
] Build Output | G Find In Files

> Press: “Reset” button on
Evaluation Kit

> LED on Port “P0.2” will light up

> Port toggle every 1ms
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Getting Started: Infineon Embedded Power SDK @
Keil uVision5 Template

11) Use Runtime Debug

> Enter “Debug Session” - 0o alE 3

{d] Start/Stop Debug Session (Strg+F5)
Enter or leave a debug session

» Left click at the dark grey area -

55 TfAAAAAAAAAAAAAAAAAAAAAAAAAAAAJ.J.J.J.J.J.AAJ.I.J.J.J.AAJ

left of the code, to place a =

*% Private Function Declarations

5']' AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA
“break Olnt” 58 Hvoid task 1lms(){
p 59 PORT ChangePin(0x02, PORT ACTICN TOGGLE):
60 L1}

> Hit “Run” or press “F5” to start B /e orrs s nn s

I
SGIT“ Private Function Declarations

.
execl |t|0n 57 Laasasassasasan st e e R AR AR AN A AR ARARARR

28 [Hvoid task _1lms(){
‘. 53 FORT ChangePin(0x02Z, PORT ACTION TOGGLE):

60 -}
HEH! RN Y

A NENCR U A Y

egisters =] "pun (F5)

> In this example: —

> Code execution stops at
breakpoint

= .

— Every time “Run” is pressed: B o2 vx v ensrnenansanenssas e RS AT RS

£
SGT“‘ Private Function Declarations

13 7
oggles Bl L eeemrrasesrrssnanseestenessmmesssssasaneeens
:

58 Hwvoid task lms(){
‘ i E-T- PORT ChangePin (0x0Z, PORT ACTION TOGGLE);
&0 L}
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Getting Started: Infineon Embedded Power SDK
Example Code

infineon

Z8F64770112

Infineon Example Code available in “Pack Installer”

@ Pack Installer - C:\Keil_v3\ARM\PACK - m] x
File Packs Window Help
o ‘ Device: Infineon - TLE9B550
ﬂ Devices ]f Boards I ﬂ ﬂ Packs/ Examples I ﬂ
Search: - X I_ Show examples from installed Packs only
Device /| Summary Example Action Description
=% Al Devices 5696 Devices = ADC1_POTI_EIM (TLE385x Eval.Board V1.01) ! Copy ADC1 with Exceptional Interrupt Mode reading in the Poti at Channel 4
[#- @ ABOV Semiconductor 20 Devices ~-ADC1_POTI_ESM (TLES85x Eval.Board V1.01) _1 Copy ADC1 with Exceptional Sequencer Mode reading in the Poti at Channel 4
¥ @ Active-Semi 4 Devices ADC1_POTI_SEC (TLE985x Eval Board V1.01) _! Copy ADC1 in Sequencer Mode reading in the Poti at Channel 4
[ @ Ambigq Micro 8 Devices ~--ADC2_VS (TLE985x Eval.Board V1.01) _1 Copy ADC2 VS Measurement
@ Analog Devices 14 Devices BDRV_CCUG_ADC1_MOTOR. (TLE985x Eval Bo... _! Copy Runs a motor with speed and direction control
[ @ ARM 51 Devices ~-BLINKY (TLE983x Eval.Board ¥1.01) _1 Copy EBlinky - blinks LED1
e AutoChips 1 Device CCUG_ADCT (TLES85x Eval.Board V1.01) _! Copy PWM synchreneocus ADC measurement, the Poti at Channel 4 adjusts the PWM
- @ Cypress 425 Devices -~ CCUG_PWM (TLE985x Eval Board V1.01) _1 Copy CCUB generates PWM signals
[ @ GigaDevice 100 Devices - CCUB_SINUSOIDAL_PWM (TLES85x Eval.Boar... 7! Copy CCUG generates sinusoidal PWM signal
- % HDSC 26 Devices ~-GPT12E_T3_COMCAT (TLES85x Eval.Board V1.... _! Copy TimerZ and Timer3 as 32bit Timer
#- @ Holtek 145 Devices ~-GPT12E_T3_RELOAD (TLES85x Eval.Board V1.01) 7! Copy GPT12E Timer3 reloaded by Timer2
[ # Infineon 174 Devices ~-MATH (TLES85x Eval.Board V1.01) _! Copy Shows the calculation speed of the MATH unit
-9 TLE9Sx Series 24 Devices ~-NVM_PROGRAMMIMG (TLES85x Eval.Board V... 71 Copy NVM Page Programming
% TLEGB4x Series 7 Devices ~-NVM_PROTECTION (TLE985x Eval.Board V1.01) _! Copy Flash Page Write Protection
E| 03 TLES85x Series 4 Devices - NVM_RAM_BRANCH (TLES85x Eval.Board V1 71 Copy Code execution in RAM
(. £ TLEsss1QXW ARM Cortex-MO, 40 MHz. 4 kB RAM, 64 kB ROM PMU_POWER_SAVING_SLEEP_MODE (TLE985x... _! Copy Power Saving Modes - Sleep Mode
ARM Cortex-M0, 40 MHz, 4 kB RAM, 48 kB ROM ~-PMU_POWER_SAVING_SLEEP_MODE_CYCLIC... _1 Copy Power Saving Modes - Sleep Mede with cyclic wake
ARM Cortex-MO, 40 MHz. 4 kB RAM, 64 kB ROM PMU_POWER_SAVING_STOP_MODE (TLE985x ... _! Copy Power Saving Modes - Stop Mode
TLESB550K ARM Cortex-MO, 40 MHz, 4 kB RAM, 96 kB ROM -PMU_RESET_STATUS (TLE985x Eval.Board V1.0...| & Reset Status Evaluation
0[3 TLEG86x Series 3 Devices = PMU_VDDEXT (TLE385x Eval.Board V1.01) VDDEXT handling
0[3 TLES87x Series 8 Devices ~-SCU_PLL (TLE983x Eval Board ¥1.01) PLL adjustment
w4 AMCI000 110 Devices SCU_PLL_XTAL (TLES9S5x Eval.Board V1.01) PLL with external XTAL
E]--‘Tx KMC4000 40 Devices ~-55C1_2_S5C2 (TLE985x Eval Board V1.01) 55C7 sends to 55C2
[ @ Lapis Semicenductor 2 Devices ~-85C1_SEND (TLE985x Eval Board V1.01) S5C1 sends data as 5P| Master
- @ Maxim 14 Devices - TIMER2_BLINEK (TLES83x Eval.Board V1.01) TIMER2 Blinking
- @ MediaTek 2 Devices ~-TIMER2_PWM_CAPTURE (TLE985x Eval.Board ... ! Copy TIMER2 PWM Duty Cycle and Period Measurement
- @ Microchip 400 Devices ~-UART1_SEMD (TLES85x Eval.Board ¥1.01) _! Copy UART1 sends data over LIN Transceiver
- @ Microsemi 6 Devices - UART2_TTY (TLE985x Eval.Board V1.01) 71 Copy UART2 sends printf messages
- MindMotion 29 Devices N
- ¥ Nordic Semiconductor 13 Devices =l | _»|i|
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